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1 Introduction

GNUbatch is a fully functioned, high performance Job Scheduler and Management
System which is available for a wide range of machines running a Unix-style Operating
System.

The product consists of a "core product" or "basic product" which contains the
scheduling software, command-line and character-based interfaces. Additional options
provide for:

An X-Windows Motif Toolkit Interface
An X-Windows GTK+ Toolkit Interface
An API for use with C and C++

An Interface for MS-Windows

An API for use with MS-Windows
Browser Interfaces

The basic manuals cover the "basic product" and the X-Windows interfaces. Additional
supplements cover the other interfaces.

The basic manuals are:
User Guide - a quick introduction and "cookbook" for use of GNUbatch

Reference manual - a complete description of all components of the basic
product.

Administrator Guide - information about installation and customisation of the
software.

Also available are:
API reference manual for Unix and MS-Windows API
MS Windows Interface Manual (this manual)
Browser Interface Manual

This manual for the MS Windows Interface describes the facilities of the Windows
interface only and assumes knowledge of the basic product.

The original version of GNUbatch was written by John Collins at Xi Software Ltd
between 1990 and 2009 as “Xi-Batch” and GNUbatch is based on Release 6 of Xi-
Batch. The names, including most of the program and service names, have been
changed to GNUbatch or derivatives and the installation directories have been
changed to conform to GNU standards. (For this reason some of the diagrams may
refer to Xi-Batch rather than GNUbatch).

The MS Windows interface is currently written for MS Visual C++ and is provided in
source form but urgently needs rewriting to use only Free Software. This manual
outlines how the MS Visual C++ version operates.
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2 Overview

GNUbatch can run on a single Unix host or several co-operating machines. The
Windows software can manage the batch jobs on one or more of these Unix hosts. It
can also submit new jobs to any one host, known as the Server. The Server is specified
at the PC, hence different PCs can use different Servers and each PC can change
Server.

The program which manages jobs is called btgw and the program to submit jobs is
called btrw. Their relationship to a group of three Unix hosts might look like this:

Uiz host; _ _
Sl n s [T iz host iz host
| [ — [ — [
tom dick harry

EBEeeT——1

=

NS
P %
BTRW BTQW

- O=

—FF

In this example, program btgw can see and manage jobs on hosts tom, dick and
harry. Program btrw submits new jobs to host tom.

2.1 Jobs & Variables

GNUbatch maintains a queue of batch jobs. Each batch job consists of a script and a
specification of what GNUbatch should do with it.

Job Control Variables are provided by GNUbatch to manage dependencies between
jobs. Jobs can include specifications to set or modify the values of variables when they
start or finish. On finishing, different operations can be specified for variables
depending on whether the job worked or failed.

The job specification also includes conditions on variables, which GNUbatch tests
before letting that job start.
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2.2 Owners, Groups and Modes

Like Unix files, all jobs and variables are owned by a user and belong to a particular
group. This is used to say who may see and edit a job or variable. These work with the
protection modes.

Each job and variable is given a protection mode. This consists of a set of permissions
dictating how various users may, or may not, access the job or variable. The modes
are like those on Unix files, providing user, group and other access. An expanded set
of permissions has been devised to enable the permissions to control separate
operations.

The modes of jobs and variables are set when they are created, however users
authorised by the mode may reset them subsequently.

In the case of jobs, the modes set by btrw are used, in default of which a set of default
modes for the given user are set.
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3 User Programs

There are three Programs which are installed on a Windows PC. The installation
normally sets up a Program group called GNUbatch Windows Interface in the Program
Manager. The programs are described in following chapters. Features that are
common to more than one program, like the dialog for setting job start times, are
described in one chapter.

The three programs are:

% Batch Queue Management Tool Shows the Queue of Batch Jobs and Set of
Job Control Variables, allowing users to change them according to the various
permissions.

Job Creation Tool enables jobs to be specified and then submitted to the
W Batch Queue. Jobs can also be "unqueued" using btgw, then changed and re-
submitted using btrw.
2l

g5 Set Up Tool configures which Unix hosts to display jobs from and which host
Btreatw tO SUbMIt jobs to.

Bt

BEtrar
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4 Btqw - Queue Management Tool
%
Bty

Btgw is a Microsoft Windows alternative to the standard batch queue manager, btqg. It
is usually invoked from the Windows Program Manager, or from the desktop by
clicking on the Btqw icon shown above.

4.1 The Main Window

When btgw is invoked the main window will be displayed, with a sub-window for jobs.
By default it will look something like this:

E'u BTCW. Xi-Bateh Windows Queus Management - Job List 1

bleah 1000 Canc

pior freed 1000 Canc

jmec jirm 1000 Canc

orres 9530 jme aallest_1 1000 BILL.DBUP Canc

orres:57621 jmc aatest ? 100020011 Canc

orres:57659 jmc aatest 3 1000 20411 Canc
torres: 57688 jme aatesl 4 1000 18:56

The main window has two key functional areas. The top area contains menus and
short cut buttons for issuing commands. The larger, bottom area, holds the sub-
windows for batch jobs and variables. These may be selected to have commands
performed upon them.

The bottom area may have any number of windows in it. It may be empty, or it may
have windows that are minimised. For example:
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Ea BTOW. ¥i-Batch Windows Queue Management - Job List 1

BE

1000 Canc
pior fred 1000 Canc
jmc jim 1000 Canc
jme aaltest 1 1000 BILL.DBUFCanc
jmc aaitest 2 100m 20011 Canc
jmec aaitest 3 1000 20f11 Canc

aatest_4 1000 2011 Canc

Export Three

This shows a sub-window with a Job List and another with a Variable list tiled
horizontally. This is an option which divides the available space equally between each
of the sub-windows, laying them out one above the other.

Just like any other windows the job and variable list could be overlapping like this:

I. LD D Fahh fWhehere e Meageierd bl aides Jai !

—p -l-_—|l.--|.|—|-|-|l b e o I—u— —pr——
= = e =
] |k sl o) e s Bl

G
150 10ER Canc

150 T0d@ EILL U e

Windows can be overlapped using the cascade option.

All of these options are available from the Window menu, which is described later. The
windows can be moved and resized just like those in any other program.

Page 6



GNUbatch Windows Interface

If both sub-windows are minimised, just their icons will be shown at the bottom of the
window like this:

T ]

Variables and jobs can be operated upon using the appropriate menu options, or
shortcut buttons. The job or variable must first be selected. This is done by clicking on
the line identifying it using the mouse. Once selected the line will be high lit.

If you cannot see the variable or job that you want then you may:
Use the scroll bar or search menu options to find it
Change the view to add the item or remove unwanted items from the display.

If a menu option or button is "greyed out" it means that a suitable job or variable has
not been selected. It may be that the required item is selected but not the sub-window
that contains it. Look at the "title bar" of the sub-window to see if it is the "active
window".

The key features of the top area are:

Iulerm bar with pull downmems prowdng access to al
irteractive quene rmaragement finctions

'-T-'.['p ETaw- oi-Batch Yandaves @ucuc Managoment - Job List l

1]

Buttons prow ding short otz to sotme of
the more popular tmets options
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4.2 The Menus and Shortcut Buttons

All commands are performed by selecting a menu option or clicking on the equivalent
shortcut button. Some of the menu options may also be selected using shortcut keys,
which are indicated to the right of the relevant options in each menu.

4.2.1 The File Menu

For tailoring the look and feel of btqw, setting up defaults, saving the tailored settings
and quitting.

Titre defaLits
Crncition refa =

Assigriment defauits

Fregran Catons
Zave File

Mok Sans
L_=zer P=rmsz

Exft

Time defaults opens a dialog for setting default time specifications for jobs.
Condition defaults opens a dialog for setting default conditions for jobs.
Assignment defaults opens a dialog for setting default assignments for jobs.

Program options brings up the Program options dialog, to tailor the look and feel of
btqw.

Save File saves various program options, in a file on the PC, as the default settings
for the next time btqw is invoked.

Network Stats opens a diagnostic window showing connection details. Ignore this
option unless Technical Support ask for information from it.

User Perms brings up a dialog showing permissions and parameters like User Load
Levels. This can also be ignored for everyday use.

Exit quits btqw.

The following shortcut buttons are provided on the toolbar.
B Is a shortcut button for program options

L-. Is a shortcut button for Save File

4.2.2 The Window menu

For opening new job and variable list windows, changing the layout of windows and
formatting their contents.
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ey Job Vincow
Mew ariable Window
Windoe Options
Cascads

Tile Horizortally

Tile Verticaly

Arrange |cons

Jotr display Format

Joby Colours L
War display fmt

=ave widths as dafault

New Job Window opens a new window containing a Job List.
New Variable Window opens a new window containing a Variable List.
b>Window Options opens a dialog for selecting which jobs and variables to display.

Cascade Re-arranges the job and variable windows so that they overlap showing the
title bar of each window.

Tile Horizontally Re-arranges the job and variable windows so that they do not
overlap. Each sub-window stretches the full width of the main window.

Tile Vertically Re-arranges the job and variable windows so that they do not overlap.
Each sub-window stretches the full height of the main window.

Arrange Icons Re-arranges any icons at the bottom of the main window into a neat
row.

Job display Format Opens a dialog for specifying the contents and layout of the
currently selected Job List.

Job Colours Opens a menu of options for displaying jobs in various states in different
colours.

Var display fmt Opens a dialog for specifying the contents and layout of the
currently selected Variable List.

Save widths as default Saves the widths set by moving the borders on the title bar
as default widths for future runs.

The following shortcut button is provided on the toolbar.

M Is a shortcut button for Window Options

4.2.3 4.2.3 The Action Menu & Buttons

For high level actions: starting and stopping batch jobs.
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Deleta job DEL
Permizsions

Title priloadlay p

Set runnable

Set canceled

Eorca pun

G job

Irterrugt jok Cirl-C
it jok Cirl-1
Other zignal

Delete job removes the selected job from the queue. This is a destructive operation,
with no way to re-queue the job. A new copy will have to be submitted if required.

Permissions brings up the dialog to set the access modes for the selected job.

Title, pri/loadlev opens the dialog for setting the Title, Priority, Command
Interpreter, and load level for the job. This is also available using the shortcut button.

Set runnable will change a job from the Cancelled, Error or Abort state to the Ready
or Run state. This option is also available using the shortcut button.

Set cancelled puts a job on held (i.e. not able to run). This option is also available
using the 'Set cancelled' shortcut button.

Force run sets a job runnable and overrides any time specification to allow the job to
run as soon as any Variable Conditions are satisfied. This option is also available using
the 'Force run' shortcut button.

Go job sets a job runnable overriding any time specification to allow the job to run as
soon as any Variable Conditions are satisfied. The repeat time on the job is advanced
to the next repetition. This option is also available using the 'Go Job' shortcut button.

Interrupt job attempts to terminate a running job by sending it an Interrupt Signal.
This option is also available using the 'Interrupt job' shortcut button and by clicking
the right mouse button over the job to select it and selecting "kill" from the pop-up
menu.

Quit job tries to terminate a running job with a Quit Signal. This option is also
available using the 'Quit job' shortcut button.

Other signal attempts to terminate a running job by sending it a specified Signal.
This option opens a selection dialog.

The following shortcut buttons are provided on the toolbar.
E Is a shortcut for Delete job

[ Is a shortcut for Set runnable

Is a shortcut for Set cancelled

Is a shortcut for Title pri/loadlev
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ﬂ Is a shortcut for Force run
m Is a shortcut for Go job

=
ﬂ Is a shortcut for Interrupt job

Is a shortcut for Quit job

4.2.4 The Jobs Menu & Buttons

Provides options for inspecting and managing batch jobs.

‘e job

Advance Timea -
Timae t
Process paramelers
Time Limitz

Ielail &rd write
Arguments
Ervironment
fiedrections

Urugusue job
Copry job
Copry options in job

Inwoke BTRVW

View job opens a text browser showing the job script to be run. This can also be
selected by using the 'View job' shortcut button and by right-clicking the mouse over
the job on the job list and selecting the option from the pop-up menu.

Advance Time skips the next scheduled execution of a job by advancing to the next
repetition. This option is also available using the 'Advance Time' shortcut button.

Time brings up a dialog for setting the start time, retention options, repetition details
and list of days to avoid. This option is also available using the 'Time' shortcut button.

Process parameters brings up the dialog to select the process parameters: working
directory, ulimit, umask, network scope and which exit codes represent an error.

Time limits opens the dialog for specifying time restrictions to terminate a runaway
job.

Mail and write opens the dialog to specify what notification is required when a job
finishes.

Arguments opens a dialog for adding, modifying and deleting arguments that are
passed to the job on its command line.

Environment opens a dialog for adding, editing and deleting the environment
variables in the jobs run time environment.

Redirections opens the dialog for specifying I/O redirections.
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Unqueue removes the job from the queue, putting a copy on the PC hard disk for
editing and re-submission using btrw.

Copy job takes a copy of the job from the queue, putting the copy on the PC hard disk
for editing and re-submission using btrw. The original job is left on the queue.

Copy options in job copies the options from the job to the defaults used in btrw.
Invoke BTRW opens program btrw.

The following shortcut buttons are provided on the toolbar.
‘%‘ Is a shortcut for View Job

."9 Is a shortcut for Advance Time

-' i) Is a shortcut for Time.

4.2.5 The Conditions Menu

Provides options for setting up pre-conditions and assignments.

Job Conditions

Job Azsignments

Job conditions brings up the dialog to add, modify and delete pre-conditions on the
selected batch job.

Job assignments brings up the dialog to add, modify and delete assignments for the
selected batch job.

Both these options are available using the toolbar buttons shown. Additionally a job
may be selected and one these options set by right-clicking the mouse over the
relevant job on the job list and selecting from the pop-up menu.

The shortcut buttons are:

“ﬂ For Job Conditions
__@ For Job Assignments

4.2.6 The Variables Menu

Provides options for manipulating variables.
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Azsign =
Increment +
Decrement

Pluiltipaly *
Divicle !

Eemainder %

Set commert

Set constant @

Assign brings up the dialog to modify the data held by the selected variable. This
option is also available on the tool-bar button and on the right-click pop-up menu.

Increment increments the value of the selected variable by the currently set
constant. This option is also available on the tool-bar button and on the right-click pop-
up menu.

Decrement decrements the value of the selected variable by the currently set
constant. This option is also available on the tool-bar button and on the right-click pop-
up menu.

Multiply multiplies the value of the selected variable by the currently set constant.
Divide divides the value of the selected variable by the currently set constant.

Remainder performs a modulo on the value of the selected variable by the currently
set constant.

Set comment brings up the dialog to modify the comment field of the selected
variable. This option is also available on the right-click pop-up menu

Set constant for the increment, subtract, multiply, divide and remainder operations.
This option is also available on the right-click pop-up menu.

The following shortcut buttons are provided on the toolbar.

=] Is a shortcut for Assign

W 41 1s a shortcut for Increment

Is a shortcut for Decrement

v-
4.2.7 The Search Menu
Both the variable and job lists may be navigated by using search options to find an

item of interest.

Search for...
Search Eorward F3
Search Backwards Fi

Search for a specified item or pattern.
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Search forward from the current position

Search backward from the current position
4.2.8 The View Menu

Specifies what is visible in the main window of btgqw.

v Show Toolbar
v Showy Status Bar

1 Jok List 1
v 2 %ariahlez List 1

Show Toolbar either shows or hides the Toolbar with the shortcut buttons. Selecting
this option when the buttons are visible hides the tool bar and vice versa.

Show Status Bar shows or hides the bar at the bottom of the main screen which
displays status information. Selecting this option when it is visible hides the status bar
and vice versa.

1 Job List 1 etc selects the specified window and brings it to the top if it is obscured
by any other windows. There will be an entry in this menu for each of the sub-windows
or icons in btgw.

4.2.9 Help

Help for using btqw.

Indlex
Uzing Help

About BT ...

Index brings up the Contents page of the Help.
Using Help gives help on using the Help system.

About displays information, such as release number, about the version of btqw that is
running.

Context Help changes the mouse pointer to show a question mark. Clicking on an
item in btgqw shows the help page for that item.

The following shortcut buttons are provided on the toolbar.

@l Shortcut for Help
k’fl Shortcut for Context Help

4.2.10 Job and variable pop-up menus

Jobs and variables may be selected and various commonly-selected options applied by
right-clicking on the job or variable list. This will select the job or variable clicked over
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and bring up pop-up menus as shown:

Set runnahble A=zign wariable
Set cancelled Incremert Yariable
Hill jok Decremert “ariable
Set Conditions Set Constant
Set Azsignments
Set comment
Wienwy Jakb
Job pop-up Yariable pop-up

4.3 Setting the Program Options

The content and format of information displayed by btqw can be customised via the
View options item under the Options menu. Confirmation for the delete commands
may also be set under this option.

Selecting this option opens the following dialog window.

Program options

Job queue " E I Including empty

Display anly user | E

Display anly group | E -

— Confirm delete johs Host offline
O MNewer @ Ignare
@ Always O Wam
—Host display Palling
O Display local host anky
L E Millisec
@ Display all hosts
[ Ungueue as hinary

Job contral files
’7 = xBC i BAT

4.3.1 Setting the Confirmation level

By default btqw asks for confirmation before deleting any job from the queue. This
may be relaxed to allow jobs to be deleted without confirmation.
Simple selection to specify Cunfiirn dulele jules ™
whether to ask for 2 Muwen
canfirmation befare

deleting batch jobs @ Always
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4.3.2 Restricting the display

The display may be restricted by effectively filtering to only show information for
selected users, groups, job queues and local or all GNUbatch hosts.

4.3.3 Restricting the display to the local host

All hosts running GNUbatch in the networked mode can be treated as a single system.
By default btqw will show all of the externally visible jobs and variables. The view can
be restricted to show just the local job queue and variables.

Simple selection ta view LDk display

information for all hosts or " Displary lueal hust vnly
just the host set as the -

‘& Digplay Al hngrs
server by btrsetw s

4.3.4 Restricting the display by job queue

The job display can be restricted by selecting a set of job queue names or patterns
matching job queues.

Text field may take a list of one or mare gueue
nares and/or patterns far matching gueue
names. Left blank it matches all queus names.

e

Includes jobs which by not being in a queue are in the
null queue. This is indicated by the depressed button.

Opens list of
queue names for
selection

| I_%_I ..Innluding Cmpty

duh ipuezam:

4.3.5 Restricting the display by user & group

The display may be restricted to jobs and variables owned by a specified user or set of

users. Similarly to users it may be restricted to one or more primary groups.
Text field may take a list of one or more user names and/or patterns
for matching user narmes. Left blank it matches all user names.

Di=play onhy user +

Di=play only group I%I .

Text field may take a list of one or more group names and/or
patterns for matching groups. Left blank it matches all groups.

COpens the
relevant lists of
narmes for
selection

Sets of users or groups may contain just one name, a list of names or a list of patterns
for matching names. The group and user names may be given as a comma-separated
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list of alternatives, including the use of shell-style wild-cards. For example

fred
jmc, tony,ukops jmc,ukops wal
ukops*,ukadmin[1-5]

The wild-card options are:

* Matches anything

? Matches one character

[a-m] Matches one character in list or range
['n-z] Matches one character not in list or range

4.4 Changing the fields displayed and their format.

There is far more information available for both jobs and variables than could be
displayed easily in the main window of btqw. Different columns of information may be
displayed as required. The field widths and handling of field overflow may also be
adjusted, however field widths may more conveniently be adjusted using the title
bars.

For example: If your batch jobs often have arguments and long titles, and you do not
need the shell column in the job display, then you could remove the shell column and
add an argument column:

To change the job or variable fields, select the appropriate option from the Window
menu.

4.4.1 Changing the Job Display

Selecting Job Display Format brings up the following window. The scrollable text
window shows the display format with each row corresponding to a column of the job
list display.

Each column may have a separator, usually one space, but any other character or
characters may be chosen.

To change the order of items on the list, drag and drop entries in new positions as
required.
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: 2 21x
Far Job lizk digplay format
i 12 Job number s e | _New FEp |
7 Hame of job owner
13 Title of job in full, including queue prefis
14 Command interpreter name o | Rt |
3 Friority o
5 Load level
et RRREE =l Reset Diefault format I
Cancel i

Each line holds the specification for one column or column divider, as follows:

o U A W N B

To edit

Crefinition for

infarmation

3 ;
Job number - s
Crefinition of

Saparator dividing
columns

Mame of joh

Crefinition for
next column of
information

. Field description / title

. Width in characters

. No action on field overflow

. Overflow onto left hand field is permitted
. Open quote before separator

. Separator character(s)

7.

Close quote after separator

an existing field select the line showing the specification for that field or

separator and click on the Edit button. Alternatively double-click on the line.

To insert a new field select the line underneath the point at which you want to insert
the new one and click on the New button, or the New sep button for a separator.

New and Edit will bring up a window looking something like this:
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Format code

‘Width

GNUbatch Windows Interface

el 4

EE- [0 Tah farmat left if too lang

[T Skipfields to right if too long

The Format code field specifies what information will be displayed in the column.
Clicking on the button at the right gives a list of the available codes for selection..

Edit Format Code

Format code

Whiclth

21x

Title of job in full. including queue prefix

Title of joh in full. including queue prefix

Conditions for jok in full
Directory used by job
Enviranment table for job
Group owner of job

Command interpreter name
Load lewvel
Mode [permissions) of job

The width is set to a suitable value for that field which can then be adjusted.

The two check boxes "tab format left" and "skip fields to right" provide for what
happens if the field is too long to fit. In the first case the preceding column is

"sacrificed" to accommodate In the second case all following columns are

"sacrificed".

4.4.2 Changing the Variable Display

The variable list format may be adjusted in exactly the same way as for jobs by

selecting the Var Display Fmt option in the Window menu.
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4.4.3 Changing the widths from the header bars

If you just need to change the widths rather than the contents, it may be more
convenient to use the header bars on the job and variable lists.

At the top of the job and variable lists are the titles, whose borders may be used to
adjust the widths of the columns to the left.

Click and drag these borders to adjust the width
of the field to the left or double-click to fit to the
widest.

[Joum | User | Title | Cmdl | Pr| Llew| Tim [
torres: 1367  jmec bleah sh 200 1000
kira:14418 pior freed sh 150 1000
MName | Value |Exp | Cmt [ils ..
kira:BILL ready Export root
kira:DBUP ready Export pior

After this has been done, the widths as adjusted may be saved using the Save
widths as default option on the Window menu.

4.4.4 Selecting job status colours.

The job list display can be enhanced by selecting different colours to represent jobs in
various states, for example green for running, blue for ready to run, red for error etc.

You can save the current scheme so that subsequent runs of btgw will use them
again.

The following illustrates the sub-menus:
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igma Window Action  Jobs  Corcibons  Wariables Search  Wew  Help

Mevy Job VWiinadone:
Menvw Yariable Window
Window Options
Crzcade

Tiie Horizontally

Tie Vertically

Arrange cons

Job cisplay Formad

Job Colours

‘or cisplay fmt

Save widths ao detoul

E

ch
sh
sh
est 1 sh

L2 sh

1000
1000
1000
1000

200
150
150
150
150

Program {nav_\r windowsl # I 150

Currant job window

1000 20£11
100020411

Canc
Canc
Canc
BILL.DBUFRCanc
Canc
Canc
i1 Canc
Canc

Cogry to Window

Error
Aot
Cancelled

The first sub-menu has four items:

Program indicates selection of colours for all new windows. This will be saved when
program options are saved from the Program menu, but will not affect the currently-
displayed job window.

Current job window changes colours for the currently-selected job window without
affecting other job windows or the program options.

Copy to application copies the colour selection from the currently-selected job
window to the program options.

Copy to window restores the colour selection of the currently-selected job window
from the program options.

Each entry in the final sub-menu brings up a Windows colour selection palette to
choose the desired colour for the text of jobs in that state.

4.5 Viewing a Batch Job

To view the script of a job either select it and the View Job option from the Job menu
or click on the toolbar button.

Alternatively right-click on the job and select View Job from the pop-up menu.
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[ &4 Job torres:10593:Example
#* sbinfsh

# Chained job example
b

# Set up programs

b

mkdir jobd
cd jobd

# First pass to process incoming requests
stated $1 42
# Second pass to generate report

repB1 52 $3

If the job is longer or wider than can be seen in the Window, scroll bars will be
provided.

Pressing the right mouse button will open the Search job data dialog. This provides
options for specifying and finding text strings within the job script thus:

Search job data |_ l_
Search " |
& Forward [ Wrap Around
.=wild card
 Backward [T lgnore Case

4.6 Changing Job and Variable parameters.

A job may be deleted, changed, reviewed by clicking on the line representing it in the
job list and then selecting the required menu option or short cut button. Variables may
be operated upon in exactly the same way. Some menu options and short cut buttons
will have an immediate effect. Others will open a dialog window for additional
information.

Many of the dialogs used by btgw and btrw are the same. They are described along
with the parameters that they affect in the chapters on Jobs and Variables.
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5 btrw - Job Submission & Editing Tool

Btrw

Used for creating, editing and submitting batch jobs, btrw is a Windows alternative to
the Unix command line program btr.

Btrw can create new batch jobs, submit them to the Unix host and save them on the
PC hard disk. It can also edit existing jobs that have been unqueued using btgw.

Saved job files can be "dragged and dropped" into btrw and jobs submitted that way.

Both btqw and btrw save jobs on the local hard disk in the same "unqueued job"
format. This uses two files, which are:

command file
Which is like a shell script, that holds the specification for the job. This shell
script contains statements to reproduce the job environment and a btr command.
The btr command has options to set up all of the job parameters and references
the job file by name. (Note that there is actually no btr command on Windows,
but the format is kept consistent with the Unix version).

job file
which contains the text, or script, of the job that is piped into the "command
interpreter" by the scheduler.

5.1 The Main Window

When btrw is invoked the main window will be displayed. By default it will look
something like this:
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‘% bichjob - Submit Xi-Batch Jobs
File Defautz Action Jobz Enwironment Conditions  Wieww  Help

Queue: Title:

{Priority: 150 Command Interpreter: Load Level: 0

Set to run when ready

The main screen is divided into two key functional areas. The top area contalns menus
and short cut buttons for issuing commands. The bottom area displays part of the
specification for the batch job which is being worked on.

Btrw uses similar windows and dialogs to btqw for specifying the job options.

To edit job scripts btrw invokes an editor of the user's choice. The editor is specified
as a default parameter in the btrw options. On installation the default editor i